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Цель: Освоить методы и инструменты работы над 
чертежами в AutoCAD. 

 





     Слои подобны наложенным друг на друга 
калькам. Их используют для группирования
взаимосвязанных объектов чертежа.
 Например, на архитектурном чертеже в одном
слое изображают план этажа, в другом — 
разводку электричества, в третьем — 
водопровода и т. д. Для слоя можно назначить
цвет, вес (толщину) и тип линий. Эти свойства
могут влиять на аналогичные свойства
расположенных на слое объектов. Для
каждого объекта чертежа задается слой, на 
котором он расположен, а также цвет, тип и вес 

линий, которыми он представлен. 



Каждому слою можно присвоить свой цвет линий. 
Назначение цвета определенной группе объектов 
играет положительную роль при выводе чертежа 
на печать – в этом случае можно будет управлять 
толщиной линий при печати. Также можно 
указать отдельные слои, которые не будут 
распечатываться. Слои можно применять для 
работы над определенными задачами, 
имеющими различное функциональное 
назначение. Например, один слой можно 
использовать для нанесения размеров, другой – 
для элементов конструкций и т.д.



• Отдельные слои можно отключить, после чего на 
экран и на печать они выводиться не будут. 
Также можно защитить отдельный слой от 
редактирования; в результате он будет оставаться 
видимым, но недоступным для случайных 
изменений.

• Одни слои можно определять для работы только 
из пространства модели, а другие – из 
пространства листа.



1.Слои -это очень важное средство AutoCAD, которое
используется для упорядочения объектов на чертеже.
 Для слоя можно назначить цвет, тип и вес линий. Все
размещенные на нем объекты, у которых эти свойства
определены как By Layer (По слою), будут иметь цвет,
тип и вес линий, заданные для слоя. 
Таким образом, вы можете создать в чертеже 
различные группы слоев с соответствующим цветом, 
типом и весом линий. В механических чертежах они
предназначаются для размещения различных 
деталей сборки, в архитектурных –для размещения
планов этажей, разводки электричества и т. д.
При работе над такими чертежами и их последующем
использовании слои можно скрывать, а также защищать от 

редактирования и вывода на печать.



• В новом чертеже имеется только слой 0, созданный с 
помощью стандартного шаблона. Этот слой 
присутствует в любом чертеже AutoCAD, и его нельзя 
удалить. Однако можно изменять его свойства, заданные 
по умолчанию (тип линий Continuous, вес линий Default, 
цвет линий № 7 White).

•  Слой 0 обычно используется как конструктивный, то 
есть изображенные на нем объекты не включаются в 
окончательный чертеж. Упомянутый слой также играет 
особую роль при работе с блоками).

• Вы можете создать в чертеже практически 
неограниченное число слоев. При этом слою 
необходимо присвоить информативное имя. Оно может 
иметь длину до 256 символов и не должно содержать 
символов пробела.



Для слоя можно не только задать определенные свойства, 
такие как цвет, тип и толщина линий, но и временно 
сделать его видимым или невидимым, запретить 
редактировать либо выводить на печать. Для управления 
слоями используются диалоговое окно Layer Properties 
Manager (Диспетчер свойств слоев) и панель 
инструментов Layers (Слои), показанная на рис.2.1.

Запустите AutoCAD и откройте файл Wilhome.dwg 
из папки C:\Program Files\ AutoCAD 
2006\Help\Tutorials. Увеличив изображение, вы 
увидите, что в чертеже применяются линии 
нескольких цветов (рис.2.2). 



• Самый простой способ управления слоями 
предоставляет диалоговое окно Layer Properties 
Manager (Диспетчер свойств слоев). Его можно 
вызвать путем выбора значка Layer (Слои) на 
панели слоев или команды Layer (Слой) из меню 
Format (Формат).

• Откроем диалоговое окно Layer Properties 
Manager (Диспетчер свойств слоев) (рис. 2.3) 
одним из указанных выше способов. Как видите, 
оно состоит из двух частей. В левой части 
отображается дерево фильтров слоев, 
имеющихся в чертеже, а в правой — таблица со 
списком слоев и их свойствами.



• Выше таблицы указан текущий слой (Current Layer). 
Это слой, на котором размещаются объекты, 
создаваемые с помощью команд черчения. Текущим 
может быть только один слой. Следует учесть, что 
чертить можно только в текущем слое, а править уже 
существующие объекты — в любом. Мы можем сделать 
слой текущим, если просто выберете любой 
находящийся на нем объект. Такой подход особенно 
удобен в случае, когда вы  хотите начертить объекты на 
одном слое с другими объектами, но не знаете точно 
имени этого слоя. Для того чтобы сделать слой объекта 
текущим, тре буется выбрать объект на нужном слое и 
щелкнуть на кнопке Make Object's Layer Current 
(Сделать слой объекта текущим) в панели слоев (первый 
значок справа от списка). После этого данный слой 
станет текущим и его имя появится в поле списка Layer 
Control (Слой) панели слоев.



Выше таблицы указан текущий слой (Current Layer). Это 
слой, на котором размещаются объекты, создаваемые с 
помощью команд черчения. Текущим может быть 
только один слой. Следует учесть, что чертить можно 
только в текущем слое, а править уже существующие 
объекты - в любом. Вы можете сделать слой текущим, 
если просто выберете любой находящийся на нем 
объект. Такой подход особенно удобен в случае, когда 
вы

 хотите начертить объекты на одном слое с другими 
объектами, но не знаете точно имени этого слоя. Для 
того чтобы сделать слой объекта текущим,

требуется выбрать объект на нужном слое и нажать 
кнопку Make Object's Layer Current (Сделать слой 
объекта текущим) в панели слоев (первый значок справа 
от списка). После этого его имя появится в поле списка 
Layer Control (Слой) панели слоев.



• В таблице со списком слоев  для каждого свойства слоя 
выделен один столбец, а значения свойств представлены 
значками или текстом. Рассмотрим описание столбцов и 
свойств слоя: 

• A)     Status (Статус) — в данном столбце отображается 
статус элемента списка. Он показывает, является 
элемент фильтром слоев, используемым слоем, текущим 
либо пустым слоем (для отображения слоев в таблице 
фильтров нужно, щелкнув правой кнопкой мыши, 
вызвать контекстное меню таблицы и выбрать в нем 
пункт Show Filters in Layer List (Показывать фильтры в 
списке слоев)). Используемым слоям соответствует 
значок в виде листа бумаги голубого цвета, а пустым 
слоям — серого. Фильтр слоев отобража ется значком в 
виде стопки листов, а текущий слой — галочкой.



 b)   Name (Имя) — в этом столбце указывается имя 
слоя. Чтобы выделить слой в списке, нужно 
щелкнуть мышью в данном столбце (или столбце 
Status (Статус)), а для изменения его имени 
следует нажать клавишу F2, а затем ввести новое 
имя.

c)   On (Вкл) — если для слоя установлено 
состояние On (значок светящейся лампочки), он 
отображается на экране. Объекты видимых слоев 
можно править и печатать, в отличие от объектов 
невидимых слоев (исключение составляет опция 
АИ (Все), например, команды Erase (Стереть)). 



d)  Freeze (Замороженный) — свойства Freeze 
(Замороженный) (значок снежинки) и Thaw 
(Размороженный) (значок солнца) имеют, более высокий 
приоритет, чем свойства On (Вкл) и Off (Выкл). 
Состояние Freeze (Замороженный) задает более жесткие 
ограничения, чем Off (Выкл). Подобно слою с 
атрибутом Off (Выкл), слой с атрибутом Freeze 
(Замороженный) невидим, его объекты нельзя 
отредактировать или распечатать. Более того, объекты 
замороженного слоя невозможно удалить с помощью 
команды Erase (Стереть) с опцией АИ (Все). Свойство 
Thaw (Размороженный) по своему действию 
противоположно свойству Freeze (Замороженный). Слой 
может одновременно иметь свойства Thaw 
(Размороженный) и Off (Выкл). Замороженные слои не 
видны даже в состоянии On (Вкл).



e) Lock (Блокированный) — слои со свойством 
Lock (Блокированный) (значок закрытого замка) 
защищены от редактирования, но они видимы и 
могут быть распечатаны.

 Объекты в заблокированном слое защищены от 
изменений. Хотя они и видны, их нельзя выбрать 
с помощью опции АН (Все) (например, 
используя команду Erase (Стереть) с опцией АН 
(Все)). 

Слой может одновременно иметь свойства Lock 
(Блокированный) и Off (Выкл).



f) Color (Цвет) — щелчок мышью на маленьком цветном 
квадрате в этом столбце приводит к отображению 
диалогового окна Select Color (Выбор цвета), 
показанного на рис. 2.4. Оно содержит три вкладки: 
Index Color (Номер цвета), True Color (Вся палитра) и 
Color Books (Альбомы цветов). Вкладка Index Color 
(Номер цвета) отображает цветовую палитру из 256 
цветов. Цвет можно выбрать непосредственно из 
палитры, а также указав в поле ввода его имя или номер. 
Вкладка True Color (Вся палитра) позволяет отобразить 
более 16 млн цветов. при использовании цветовой 
системы RGB либо HSL. С помощью вкладки Color 
Books (Альбомы цветов) можно назначать цвета из 
палитры плашечных цветов.



g)  Line type (Тип линий) — после щелчка на элементе 
этого столбца появляется диалоговое окно Select Line 
type    (Выбор типа линий), предназначенное для выбора 
типа линий. В шаблоне, заданном по умолчанию, 
доступен всего один тип линий — Continuous. Для того 
чтобы в чертеже можно было использовать другие типы 
линий, загрузите их, щелкнув на кнопке Load 
(Загрузить), или воспользуйтесь шаблоном чертежа, 
содержащим все необходимые типы линий (см. занятие 
8). Line welght (Вес линий) — в результате щелчка на 
элементе в этом столбце отобразится одноименное 
диалоговое окно, которое используется для выбора веса 
линий (рис. 2.5).



• h)  Plot Style (Стиль печати) — этот столбец диалогового 
окна Layer Properties Manager (Диспетчер свойств слоев) 
управляет назначением стиля печати для слоя. 

• Plot (Печать) — если слой не подлежит печати, в этом 
столбце поверх значка принтера находится символ 
запрета (значок перечеркнут). Запретить печать слоя 
можно, щелкнув мышью на значке принтера или 
установив свойство Freeze (Замороженный) либо Off 
(Выкл).

• Description (Пояснение) — этот столбец предназначен 
для создания пояснений к слою либо фильтру. 
Щелкните мышью в этом столбце напротив имени слоя, 
для которого вы хотите создать пояснение, нажмите 
клавишу F2 и введите текст пояснения. 



• 3. Создание  слоёв в AutoCAD 
1.Создайте в AutoCAD новый чертеж с метрическими 

установками.
2.Откройте диалоговое окно Layer Properties Manager 

(Диспетчер свойств слоев) и создайте три новых слоя: 
Основные, Штриховые и Осевые. Используйте кнопку 
New Layer (Новый слой). Каждый раз после ввода 
имени слоя нажимайте кла вишу Enter. 

3.Выберите слой Штриховые и задайте для него 
соответствующий тип линий, щелкнув в столбце Line 
type (Тип линий). На экране появится диалоговое ок но 
Select Linetype (Выбор типа линий), однако выбирать в 
нем не из чего. По этому щелкните на кнопке Load 
(Загрузить), чтобы открыть диалоговое окно Load or 
Reload Line types (Загрузка или перезагрузка типов 
линий) (рис. 2.9).



Рис. 2.2. Диалоговое окно Load or Reload Linetypes



• Отметьте в этом окне первый и третий 
элементы списка (при выборе удерживайте 
клавишу Ctrl нажатой) и щелкните на кнопке 
ОК. После этого диалоговое окно Select Line 
type (Выбор типа линий) будет выглядеть так, 
как показано на рис. 3.10.

• Выделите штриховой тип линии, чтобы 
назначить его слою Штриховые, и закройте 
окно, щелкнув на кнопке ОК.

• Задайте для слоя Осевые штрихпунктирную 
линию (см. пункты 3 и 4).



Рис. 2.3 Диалог. окно Select Line type   с загруженными типами линий



4.  Выделите штриховой тип линии, чтобы назначить его слою
Штриховые, и закройте окно, щелкнув на кнопке ОК. 
5. Задайте для слоя Осевые штрихпунктирную линию (см. пункты 3 и 

4).
6. Назначьте для созданных слоев разные цвета. Например, 
слой Основные сделайте синим, слой Штриховые — зеленым, а
 слой Осевые - голубым. Для этого в отношении каждого слоя 
нужно выполнить следующие действия: выбрать слой из списка
 в диалоговом окне Layer Properties Manager (Диспетчер свойств 

слоев), щелкнуть в столбце Color (Цвет), в
Открывшемся  диалоговом окне Select Color (Выбор цвета) (см.
рис. 3,4) выбрать цвет и закрыть окно, щелкнув на кнопке ОК.
7. Сделайте текущим слой Основные. На данном этапе в
диалог. окне Layer Properties Manager (Диспетчер свойств 
 слоев) должны быть выполнены установки, показанные на рис.
 2.11. 
Убедившись в этом, закройте диалоговое окно щелчком на кнопке ОК. 



Рис. 2.4. Диалоговое окно Layer Properties Manager с установками для слоев



8.Включите режимы ORTHO (ОРТО) и GRID (СЕТКА). 
Используя команду Line (Отрезок), начертите 
основные линии вида, изображенного на рис. 2.12. 
Обратите внимание на то, что они представлены 
непрерывной линией синего цвета. Именно такие 
установки были сделаны для слоя Основные, который 
и является на данный момент текущим.

9.  Сделайте текущим слой Осевые. Для этого откройте 
список панели слоев и щелкните на имени данного 
слоя.

10. Установите режим привязки к середине объекта, а 
затем вызовите команду Line (Отрезок) и начертите 
ось отверстия. Как видите, она представлена 
штрихпунктирной линией голубого цвета.



11. Сделайте текущим слой Штриховые и начертите 
границы отверстия (они будут представлены штриховой 
линией зеленого цвета).

• В данном случае вы не назначили свойства объектов 
явно, поэтому объекты унаследовали свойства, заданные 
для слоя. С этой целью значение свойства объекта 
установлено равным By Layer (По Слою). Данный 
метод используется в AutoCAD по умолчанию.

• Как же увидеть свойства объекта? В AutoCAD для этого 
имеется специальная команда. Кроме того, вы можете 
воспользоваться панелью свойств. В свер нутом 
состоянии четыре списка панели обычно отображают 
свойства слоя, но если вы выберете объект, в панели 
появятся его свойства.



Рис. 2.5 Деталь, представленная разными линиями



12. Текущим в данный момент является слой 
Штриховые. Это отражает и панель слоев (см. 
рис.2.12). Выберите линию, представляющую 
контур детали (синюю), и обратите внимание 
на панель свойств, в которой теперь указаны 
такие свойства линии: слой — Основные, а 
цвет, тип и вес — By Layer (По Слою).

13. Вызовите команду Modify ► Properties (Редакт. 
► Свойства), после чего появится палитра 
свойств для линии, выбранной в пункте 12 (рис. 
2.13). Обратите внимание, что слой, цвет, тип и 
вес линии такие же, как в панели свойств.



Содержимое палитры свойств меняется в зависимости от 
типа и количества выбранных объектов. Вы можете 
сначала вызвать палитру, а затем выбрать один объект 
или несколько объектов либо сделать наоборот: сначала 
выбрать объекты, а потом вызвать палитру. Будучи 
однажды открытой, палитра остается на экране до тех 
пор, пока вы не щелкнете на кнопке закрытия палитры. 
Используя комбинацию клавиш Ctrl+1, можно убирать 
палитру с экрана и вызывать ее вновь. При выборе сразу 
нескольких объектов в верхней части палитры 
появляется список. В нем можно указать объект, 
свойства которого требуется изменить.



14. Измените цвет выбранной линии. Для этого в 
палитре свойств щелкните мышью на строке 
свойства Color (Цвет), а затем, щелкнув на 
кнопке со стрелкой, разверните список 
возможных значений этого свойства. Выберите в 
нем крас ный цвет. Закройте палитру свойств и 
посмотрите на панель свойств — теперь цвет 
объекта в ней задан явно и не зависит от слоя. 
Аналогичные изменения можно произвести и с 
помощью панели свойств.



Рис. 2.5. Палитра свойств для определения свойств линии



**Если цвет, вес и тип линий объекта определяются по 
слою (заданы как By Layer (По Слою)), вы можете 
изменить эти свойства, переместив объект на другой 
слой. Для этого достаточно изменить значение 
свойства Layer (Слой) объекта.

• Выполняя данное упражнение, прежде чем чертить 
линию с теми или иными свойствами, вы делали 
текущим соответствующий слой. Однако в программе 
AutoCAD, для того чтобы создать объект с 
определенным цветом, типом и весом линий, можно 
использовать также специальные команды: Line type 
(Типы линий), Line weight (Веса линий) и Color (Цвет), 
которые находятся в меню Format (Формат). Далее 
описана работа этих команд.



15. Отмените выбор объектов, нажав для этого 
клавишу Esc. Вызовите команду Linetype (Типы 
линий) из меню Format (Формат), в результате 
чего на экране отобразится диалоговое окно Line 
type Manager (Диспетчер типов линий), 
показанное на рис. 2.14.

• Оно похоже на диалоговое окно Select Linetype 
(Выбор типа линий), которое применяется для 
назначения типов линий слоям (см. рис.3.10). Но 
если тип линий назначен с помощью диалогового 
окна Line type Manager (Диспетчер типов линий), 
он присваивается не слоям, а объектам. 



Рис.2.6. Диалоговое окно Linetype Manager



В этом случае черчение объектов будет 
выполняться заданными линиями независимо от 
установок слоя (если только в окне не выбрано 
значение By Layer (По Слою)). Когда тип линии 
выбирается с помощью команды Layer (Слои) (в 
диалоговом окне Layer Properties Manager 
(Диспетчер свойств слоев)), назначение типа 
линии осуществляется для слоя. Пока вы не 
приобретете достаточного опыта в 
использовании обоих методов, их совместное 
применение в одном чертеже может привести к 
путанице.



16.Выберите из списка в диалоговом окне Linetype 
Manager (Диспетчер типов линий) тип линий 
Continuous и один раз щелкните на кнопке Current 
(Текущий) либо дважды щелкните на строке с этим 
типом линий. Закройте окно, щелкнув на кнопке ОК. 
Данный тип линий будет оставаться текущим до тех 
пор, пока вы не выберете другой.

17.Текущим сейчас является слой Штриховые (для него 
заданы зеленые штриховые линии). Вызовите команду 
Line (Отрезок) и начертите несколько линий. Вы 
получите зеленые непрерывные линии (зеленые, 
поскольку они расположены в слое Штриховые, 
непрерывные — потому что текущим установлен этот 
тип линий).



• Еще раз вызовите диалоговое окно Line type 
Manager (Диспетчер типов линий) и установите 
текущим тип By Layer (По Слою). Теперь при 
последующем черчении объекты будут 
наследовать тип линий, назначенный для слоя, 
что более удобно.

• Вызовите команду Format ► Lweight (Формат 
► Веса линий), после чего поя вится 
диалоговое окно Une weight Settings 
(Параметры весов линий), показанное на рис. 
2.15. Его функции подобны функциям 
диалогового окна Linetype Manager (Диспетчер 
типов линий); однако вес линий в нем 
назначается для новых объектов, а не для слоев. 



Рис. 2.7. Диалоговое окно Lineweight Settings



• Для того чтобы вес линий определялся по слою, выберите 
элемент By Layer (По Слою). Если вы хотите, чтобы все 
слои имели один и тот же вес линий, воспользуйтесь 
элементом Default (По умолчанию).Диалоговое окно Line 
weight Settings (Параметры весов линий) содержит 
следующие элементы управления:

□ Units for Listing (Единицы списка)-вес линии можно задать 
в миллиметрах (мм) или дюймах (in). 

Значения, перечисленные в списке Line weights 
Веса линий),обозначают толщину выбранной линии.
□ Display Line weight (Отображать линии по их весам) 

установка этого флажка приведет к тому, что присвоенный 
вес линии будет отображаться как в пространстве модели 
(вкладка Model), так и в пространстве листа (на вкладках 
Layout). Данный флажок выполняет ту же функцию, что и 
кнопка LWT (ВЕС) в строке состояния.



• □ Default (По умолчанию) — хотя в новом чертеже
 текущим весом линий является By Layer (По Слою), все 

создаваемые слои будут иметь вес линий Default (По 
умолчанию). Такой особенностью обладает только вес 
линии. После выбора в списке Default (По умолчанию) 
нового значения изменится

• толщина линий во всех существующих слоях и 
объектах, имеющих толщину линий Default (По 
умолчанию); она будет присваиваться всем

 создаваемым слоям (и объектам). Изменение веса линий в 
существующих слоях, имеющих установку By Layer (По 
Слою), придется производить для каждого слоя 
отдельно.



 □ Adjust Display Scale (Масштаб экранного 
отображения) — эта настройка влияет только на 
отображение веса линий в пространстве модели 
(вкладка Model), в диалоговом окне Lineweight 
Settings (Параметры весов линий) и в списке Line 
weight Control (Веса линий) панели свойств. 
Здесь толщина линии отображается в пикселах 
пропорционально ее истинному значению, с 
которым она отображается в пространстве листа 
(вкладка Layout) и выводится на печать.



20. Вызовите команду Format ► Color (Формат ►
Цвет), которая позволяет назначить цвет новым
объектам. Явная установка цвета переопределяет 
установку цвета по слою для всех создаваемых
 объектов, и все новые объекты чертятся заданным
цветом независимо от цвета слоя, на котором они
находятся. После вызова команды Color (Цвет)
появляется диалоговое окно Select Color (Выбор цвета) 

(рис. 2.16). В основном это окно не отличается от того, 
которое используется для присвоения цвета слоям, но 
здесь доступны кнопки ByLayer (ПоСлою) и ByBlock 
(ПоБлоку). Используя команды Lweight (Веса линий) 
и Color (Цвет) меню Format (Формат), назначьте вес и 
цвет линий для новых объектов и начертите несколько 
линий. Это позволит вам лучше понять действия, 
которые производятся каждой из команд.     Закройте 
чертеж, не сохраняя его. 



• В завершение рассмотрим еще одну команду, предназначенная 
для работы со свойствами объектов. Речь идет о команде Match 
prop (Копироваться). В меню Modify (Редакт.) ей соответствует 
пункт Match Properties (Копировать свойства). Команду можно 
вызвать также с помощью стандартной панели инструментов, 
щелкнув на кнопке с изображением кисточки. Команда Match 
prop (Копироваться) используется для передачи свойств одного 
объекта другому. После ее вызова вы должны сначала выбрать 
объект, обладаю щий необходимыми свойствами (объект-
источник), а затем объект, которому вы хотите передать эти 
свойства (объект-приемник). Можно выбрать один объект-
источник и перенести его свойства на несколько объектов-
приемников.

• Кроме базовых свойств объекта, таких как цвет, слой, тип и вес 
линии, с помощью данной команды можно пировать и 
специфичные его свойства — размера, штриховки, текста 

таблиц, а также поли линий и видовых экранов пространства листа.



Рис. 2.7. Диалоговое окно Select Color, вызываемое с помощью команды Color



Размеры. 
1.Размеры в ACAD. Построение размеров. 
2.Управление размерными стилями.
    Размеры показывают геометрические величины
объектов, расстояния и углы между ними, а также 

координаты отдельных точек.
    Размеры можно разделить на 5 основных типов:
линейные, радиальные, угловые, ординатные  и 

    длины дуг.
Линейные делятся на горизонтальные,
вертикальные, параллельные, повёрнутые, базовые
и размерные цепи. 



1. Процесс нанесения размеров является 
полуавтоматическим. Поэтому для управления 
его ходом применяются размерные переменные.

 С их помощью можно управлять высотой текста, 
величиной стрелок, направлением стрелки 
выноски в радиальных и диаметральных 
размерах, форматом текста и многими другими 
параметрами.

 
Группе значений переменных можно присвоить 
имя и сохранить ее в качестве размерного стиля.



Нанесение размеров.AutoCAD позволяет 
наносить размеры трех типов: линейные, угловые 
и радиальные. В AutoCAD 2006 появилась также 
возможность нанесения размера длины дуги 
окружности. В зависимости от типа объекта и 
ориентации начальных выносных линий размеры 
могут быть: горизонтальными, вертикальными, 
параллельными, повернутыми, ординатными. 
Размеры также могут проставляться от базовой 
линии или располагаться цепочкой на одной 
линии. В большинстве случаев под размером 
понимают совокупность размерных линий, 
выносной линии, текста размера (как правило, 
числового значения), и стрелок или засечек. 





• Размерный текст указывает значение размера
• Размерные линии показывают величину размера 

и его ориентацию; в угловом размере размерная 
линия представляет собой дугу. 

• Стрелки ограничивают размерную линию и 
располагаются на ее концах. Можно задавать 
размеры стрелок, изменять их форму, а также 
использовать вместо них другие обозначения 
(засечки или точки). Выносные линии идут

от объекта к размерной линии. Маркер центра  
имеет вид крестика и обозначает центр круга или 
дуги. Центровые линии выходят из маркера 
центра и имеют разрывы в центре.



2. Команды нанесения размеров можно вызывать из меню 
Dimension (Размеры) или из одноименной  панели 

инструментов, отобразив ее с помощью контекст-го меню:
 



По умолчанию размеры в ACAD ассоциативны, 
т.е. начальные точки выносных линий связаны с 

измеряемыми объектами. 

Вследствие этого при выполнении команд  Stretch 
(Растянуть), Rotate (Повернуть), Scale (Масштаб), 
а также после правки объектов с помощью ручек
значение, указанное в тексте размера, обновляется 

автоматически.

 Конкретное использование команд, в т.ч. и с 
помощью ручек, рассмотрим на практике (Пз).



3. Поскольку процесс нанесения размеров в 
AutoCAD является полуавтоматическим, для 
управления его ходом применяются размерные 
переменные. С их помощью можно задавать тип 
стрелок, ориентацию текста, текстовый стиль, 
единицы и точность измерения, отображение 
выносных линий, расположение текста и 
стрелок, а также направление выноски для 
радиусов и диаметров. Одной из размерных 
переменных является DIMSACLE; она задает 
общий масштаб элементов размера (текста, 
стрелок, зазоров между размерной линией и 
текстом). 



Если установить для нее значение 1,5, то величины 
всех масштабируемых элементов размера 
увеличатся в полтора раза по сравнению со 
значениями, предлагаемыми по умолчанию. 
Изменение размерных переменных обычно 
производят до создания соответствующих 
размеров, поскольку эти изменения обратной 
силы не имеют, то есть не действуют на 
существующие в чертеже размеры.



Набор значений размерных переменных, 
сохраненных под определенным именем, 
называется размерным стилем. По умолчанию в 
шаблоне чертежа содержится один размерный 

стиль - ISO-25 (метрический) или Standard (англ.). 
Все размерные переменные этих стилей имеют 

значения, принятые по умолчанию. 
Можно создать в чертеже произвольное число 

размерных стилей, присвоить им имена и задать 
установки. Когда размерный стиль становится

текущим, AutoCAD использует для этих размеров 
хранящиеся в нем значения переменных.



Существует два основных способа управления 
размерными переменными:

 - использование диалогового окна Dimension Style 
Manager (Диспетчер размерных стилей) и 

- ввод имени переменной в командную строку.
 Диалоговое окно в этом случае предоставляет 

понятные пользователю названия элементов 
управления, в то время как в командной строке 
применяются имена размерных переменных.

 



Необходимо понимать, что имя размерного стиля 
фактически является именем семейства 
размерных стилей. В состав каждого семейства 
входит один стиль - предок, а иногда еще и до 6 
стилей-потомков, которые задают внешний вид 
линейных, угловых, диаметральных, радиальных 
и ординатных размеров, а также выносок. 
Изначально все потомки одного семейства имеют 
одинаковые установки размерных переменных, 
однако у одного или нескольких потомков их 
можно изменить, после чего имена данных 
потомков отображаются в диалоговом окне 
Dimension Style Manager под именем семейства 
стилей.



Изменение размерного стиля следует рассмотреть 
 на Пз, или изучить самостоятельно. При этом 
вызывается из меню команда
                                    Dimension> Dimension Style,
В результате появится d.Ok. «Dimension Style
Manager», c помощью. которого выбираются
 нужное семейство стилей. Для этого щёлкаем на
кн. New(новый) для активизации d.Ok. Create New
 Dimension Style (Создать новый размерный стиль).  



4. Нанесение размеров почти всегда является
последним этапом процесса создания чертежа и
часто приходится менять порядок настройки 

чертежа, и подход к выбору коэфф. масштаба. 
При этом необходимо выбирать специальные 
правила нанесения размеров. Размеры можно 
наносить в пространстве модели и связывать их

с объектами этого пространства, определяющими
геометрическую форму конструкции. Задавая
параметры, определяющие внешний вид размеров,
нужно учитывать, из какого пространства (модели 

или листа) будет осуществляться печать.



Нанесение размеров в пространстве листа

• Обычно файл чертежа включает изображение
   проектируемой конструкции, созданное в 

пространстве модели, и как минимум один лист, 
применяемый для вывода чертежа на печать. 



Создание размерных стилей для шаблона чертежа
Вместо того чтобы создавать для каждого нового 

чертежа одни и те же размерные стили, имеет 
смысл использовать шаблон чертежа с 
заготовленными размерными стилями.

1. Создайте новый чертеж или откройте 
существующий шаблон. Присвойте ему 
информативное имя.

2. Создайте слой DIM, на котором будут 
размещаться размеры. Назначьте для него 
соответствующий тип, вес и цвет линий.



3. Установите значение общего масштаба, 
учитывая параметр Limits (Лимиты) и формат 
бумаги, используемой при печати. Измените 
значения других размерных переменных, чтобы 
придать большинству размеров вид, отвечающий 
стандартам.

4. Сохраните размерный стиль под именем 
Template. Он будет использоваться в качестве 
шаблона при создании большинства размерных 
стилей.



5. Создайте размерные стили, которые требуются 
для нанесения размеров на чертеж. При 
необходимости используйте в качестве шаблона 
размерный стиль Template.

6. Сохраните созданный шаблон чертежа и 
выйдите из него.

7.  Используйте данный шаблон при создании 
новых чертежей. При необходимости внесите 
изменения в размерные стили, создав 
переопределители.


